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control of the author and the publisher.
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Publisher’s Note

After successfully publishing youth-oriented books and getting commendable appreciation from
students, teachers and parents alike, V&S Publishers is venturing into the arena of student and
job-oriented books with a series of computer books on various important subjects for readers
of all ages. Written and presented in lucid language and simple terms, without any computer
jargon, these books are an easy-to-follow manual for readers. For the convenience of readers
the information is set out in an easy to understand, step-by-step format, with clear illustrations
and detailed explanations to accompany each action. Besides, every book is accompanied by an
interactive CD/DVD for better understanding of the readers.

Today we live in a world of computers. The present scenario is that computers are used in every
field be it education, business, trade and commerce, home and hobby, or even our ordinary day-
to-day life. The importance of computers is an undeniable fact in today’s world. In fact, we can’t
think of a world without computers.

Realising this indisputable fact, we are coming up with the series of “Comprehensive Computer
Learning (CCL)” books. The series currently includes —

1. Comprehensive Computer Learning (CCL)
2. Comprehensive Computer Learning — A Youngsters’ Guide
3. Comprehensive Computer Learning — Microsoft Office 2010
4. Comprehensive Computer Learning — Desktop Publishing (DTP)
5. Comprehensive Computer Learning — Adobe Photoshop
Key features of these books:
Written in simple and lucid language

O Presented in step-by-step, easy-to-understand format with detailed explanations with
appropriate images & screenshots, charts & tables

d Useful tips and notes given in every chapter as additional information

O  Accompanied by interactive CD/DVD for better understanding



This book “Comprehensive Computer Learning — Microsoft Office 2010” has been explicitly
written keeping in mind the needs of Youngsters and explains the basics of computer in simple &
precise manner.

While every effort has been made to minimise printing and other errors, it may be possible that a
few might have managed to escape the wakeful eyes. We would like to request the readers to bring
these errors to our notice so that we can rectify the same in subsequent editions.



Preface

This book is for the users of Office 2010 who want to learn the program without wasting time
and efforts. Not only look in this book to find out how the different programs in the Ofhice Suite
work & how to learn them, look in this book to find out how you can get your work done better
and faster with these programs. Here we will discuss basics and advanced concepts of MS Office.

What Makes this Book Different

You are holding in your hands a computer book designed to make mastering the Office programs
as easy and comfortable as possible. Besides the fact that this book is easy to read, it’s different
from other books about Office. Read on to see why.

What do you need
U Latest Edition of Microsoft office 2010

O Windows operating system: All people who have the Windows operating system installed
on their computers are invited to read this book. It serves for people who have Windows 7,
Windows Vista, Windows XP, and Windows NT.

Q A little Knowledge of English
What will you get

After a comprehensive reading of this book you will be able to do a variety of jobs. And you will
notice that now you can do all office-related works.

— Bittu Kumar
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4 n this Chapter you will learn

B How to Install Microsoft-Office 2010 on your Computer.

B Step-by-step guide of installing Microsoft Office 2010 on your
Computer.

The Most Important thing is installing the Microsoft Office on your Systems First. You can do it by
purchasing a genuine copy of Microsoft Office from nearest software outlet, or simply download
it from the Microsoft’s official website. Here we are discussing setup instructions for Microsoft
Office Professional Plus 2010.

After buying CD/Downloading files, follow these Instructions:

v" Go to the File directory where the Microsoft office setup is.

B » MY computer » Local Disk (D:) » setup » msoffice » Microsoft Office 2010 ProPlus » ~ [ 49 [ Search Microsof.. £

File Edit View Tools Help
Organize v [B Open v Bum  Newfolder &~ 0O @

X Favorites § N Accessen-us Admin Catalog 1| Excelen-us
I Deskiop D File folder File folder File folder ﬂ File folder

(8 Downloads ~ -
InfoPath.en-us ID | Officeen-us Officebd.en-us

% Recent Places | Grooveen-us
File folder File folder | File folder File folder

i
: )

o 1 OneNote.en-us
E"'"“‘s II:I File folder
3 Documents

b Outlook.en-us 11 PowerPoint.en-us 11 Proofing.en-us
| File folder | Fiefolder File folder

o Music P ProPlusww

) Pictures File folder

B Publisher.en-us 1] Rosebud.en-us ] Updates
| File folder | Fie folder | File folder
B Videos * =i

= Microsoft Office 2010 Pro Plus setup
(B naresh D ‘;’I‘e"f‘oﬁ‘;“ % Mutti Key 2| Microsoft Setup Bootstrapper

3 AppData =] TetDocument
Contacts

(B Desktop

(8 Downloads

(B Favorites

(3 Links

My Documents.
@b My Music

My Pictures

[ My Videos
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v" Now click on Setup.exe and click on yes (In the case you are using Windows 7 or Vista).

V' After sometime, the following dialog box will appear on your computer, Click “Install Now”.

@
., Choose the installation you want

Please choose your preferred type of Microsoft Office Professional Plus 2010
installation below.

Install Now

Customize

v' The following box will appear on clicking “Install Now”, wait for a few minutes and let
Microsoft office 2011 be installed on your system.

e
©

Installation Progress

Installation Progress

t | ' d

Installing Microsoft Office Professional Plus 2010... Installing Microsoft Office Professional Plus 2010...

Installing MS Office 2010 g
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Thank you for installing Microsoft Office Professional Plus 2010. To use an Office
program, open the Start menu, find the Microsoft Office folder, and dlick the program
icon.

Complete your Office experience
« Store and share your documents online
« Get free product updates, help, and training

Continue Qnline

Now you have successfully Installed Microsoft office 2010 on your Computer. Now we shall begin
Microsoft Office 2010 Basic Course

Points to Remember

== Always use genuine software from Microsoft. Pirated software may contain
Viruses & other Malwares.

w Your Serial-Key is personal to you,; don t share it with anyone before installing
and activating the Product.

ws Never download the Microsoft Product from any other website other than
Microsoft. You can try beta versions before you buy.

é?
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B Introduction to different Microsoft Office programs

Basic Information on the Graphical-User Interference

Using different tabs in office Programs

|

|

B Creating, Saving & Editing your work

B Saving File in the earlier versions of Microsoft Office
|

Encrypting the documents

Office 2010, sometimes called the Microsoft Office Suite, is a collection of computer programs.
Why is it called Office? I think, because the people who developed it wanted to make software for
completing tasks that need doing in a typical office. When you hear someone talk about “Office”
or the “Office Software,” they’re talking about several different programs:

O Word: A word processor for writingletters, reports, and so on. A Word file is called a document.
Q Outlook: A personal information manager, scheduler, and e-mailer.

O PowerPoint: A means of creatingslide presentations to give in front of audiences. A PowerPoint
file is called a presentation, or sometimes a slide show.

Q) Excel: A Part of office for performing numerical analyses. An Excel file is called a workbook.
Q) Access: A database management program.

Q) Publisher: A means of creating desktop-publishing files — pamphlets, notices, newsletters,
and even books!

Introduction to MSOffice 5‘,’



If you're new to Office, don’t study so many different computer programs. The programs have
much in common. You find the same commands throughout Office. For example, the method of
choosing fonts is the same in Word, Outlook, PowerPoint, Excel, Access, and Publisher. Creating
diagrams and charts works the same way in Word, PowerPoint, and Excel.

Starting an Office Program

Unless you start an Office program, you can’t create a document, construct a worksheet, or make
a database. Learn how you can do that.

v" Click the Start button, choose All Programs = Microsoft Office, and then choose the

program’s name on the submenu.

User Interface in Microsoft Office

Interface, also called the user interface, is a computer term that describes how a software program
presents itself to the people who use it.

Introduction to the GUI
U File tab

In the upper-left corner of the window is the File tab, Go to the File tab to find commands
for creating, opening, and saving files, as well as doing other file-management tasks. Notice

n Home | Insert  Page Layout References Mailings Review  View Nitro PDF Professional 7 m
e ;
% cut % Tl L = = 44 Find ~
|,j i Galibri(Body) ~[11 - A" A7 | Aav | % i AaBbCcDe | AzBbccDe AaBbCi AaBbCe AALB 4aBbce. assbecoe Byt
53 Copy Y Lae
Paste v A A _ Change
St romatpanter | B L U e o [ -2 A THormal |TNoSpac.. Headingl Heading2  Title subttle  SuptieEm.. o CHATGE | o
Clipboard Al Font Styles | Editing
Ha9-0 =
=] T T e e T R o AT i % ¥ | B
. v
:
. =]
, =
Page:1of1 | Words:0 |E}Eﬂ BE= e (O—U—@
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the Options command. You can choose Options to open the Options dialog box and tell the
program you are working in how you want it to work.

The Ribbon and its tabs

Across the top of the screen is the Ribbon, an assortment of different tabs; click a tab to undertake a
task. For example, click the Home tab to format text; click the Insert tab to insert a table or chart.

W Insert Page Layout References Mailings Review View Nitro PDF Professional 7 a -d
% cut e = e e - = A 4 Find ~
[ﬁ B oo GelibriBody) -[11 | A" A7 | A B 2 24 | | nasbcenc| asBbcepe AaBbCi AaBbce AAB 4asbee. AnEchDA‘ T
%
Paste S A~ A : ? : cm"
e Formatrainter | B £ U e %, X' | & 0-A [H~ || TNomal |TNoSpad.. Headingl Heading2 Tl Subtitle  Subtle Em... \_ 0 {1 S
Clipboard W Font i Paragraph r‘ Styles |  Editing
H92-0 -
eferences  Mailings. ew  Nitro PDF Professional 7 e — g
=) = @ i B & 4 L5 T Q
EE= II = | : e
Cover | Blank hge Table | Picture cnp Shapes SmartArt Chart Screenshot | Hyperlink Bookmark Cross-reference | Header Footer Page Text Quick WordArt Drup Equation Symbol
|Page~| Page Break = Number~ | Box~ Pats~ - "8 Object ~ - -
Pages Tables Tllustrations Links Header & Footer Text Symbols

L o —y W
mFoms $1 Line Numbers ~ o~ 4 ,,. Before: [0 pt I8 Group ~

Margins Orientation  Size ~ Columns Watermark Page Position Wrap _ Brin Send  Selection
‘ l.mms o > > ‘J 3 .

¥ = Pau S
bE" Hyphenation ~ Color~ Borders | 2 Right: |0° 21 3Zater jt0pt Text+ Forward - Backward~ Pane .k Rotate -
1hemes Page Setup i) Page Background ~ Paragraph ] Arrange
SEER gt Rt Slo9nbR menet

Your first step when you start a new task is to click a tab on the Ribbon. Knowing which tab to
click takes a while, but the names of tabs — Home, Insert, View, and so on — hint as to which
commands you find while you visit a tab.

To make the Ribbon disappear and get more room to view items on-screen, click the Minimize
the Ribbon button (or press Ctrl+F1). This button is located on the right side of the Ribbon, to
the left of the Help button. You can also right-click the Ribbon and choose Minimize the Ribbon
on the shortcut menu, or double-click a tab on the Ribbon. To see the Ribbon again, click the
Minimize the Ribbon button, press Ctrl+F1, double-click a Ribbon tab or right-click a tab name
or the Quick Access toolbar and deselect Minimize the Ribbon on the shortcut menu. While the
Ribbon is minimized, you can click a tab name to display a tab.

The Description of a tab
Groups

Commands on each tab are organized into groups. The names of these groups appear below the
buttons and galleries on tabs. For example, the Home tab in Word is organized into several groups,
including the Clipboard, Font, Paragraph, Styles.

Home ] Insert  Pagelayout  References  Mailings  Review  View  Nitro PDF Professional 7

% Cut [Calibri Body <111 ~| A* A~ > i - &4 Find
B cong |catbriody) 11 | A K| A B | naBbccDc | AsBbcede AaBbCi AaBbce AADB 4aBbec. acsbeen ‘A Fek
Pasle < Format Painter B Z U-abex, X|A-2-A- | fNormal |17 NoSpaci.. Headingl Heading 2 Title Subtitle  Subtle Em... }jﬂ'a" e v Select~
Clipboard & Font [ Paragraph i Styles 5| Editing
@90 -
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Groups do the following:

Q) Groups tell you what the buttons and galleries above their names are used for. On the Home
tab in Word, for example, the buttons in the Font group are for formatting text. Read group
names to help find the command you need.

0 Many groups have a group button that you can click to open a dialog box or task pane (officially,
Microsoft calls these little buttons dialog launcher).

Buttons

Go to any tab and you find buttons of all shapes and sizes. Square buttons and rectangular
buttons; big and small buttons, buttons with labels and buttons without labels. Is there any rhyme
or reason to these button shapes and sizes? No, there isn’t. What matters isn’t a button’s shape or
size, but whether a down-pointingarrow appears on its face:

Q) A button with an arrow: Click a button with an arrow and you get a drop-down list with
options you can select.

QO A button without an arrow: Click a button without an arrow and you complete an action of
some kind.

QA hybrid button with an arrow: Some buttons serve a dual purpose as a button and a drop-
down list. By clicking the symbol on the top half of the button, you complete an action; by
clicking the arrow on the bottom half of the button, you open a drop-down list. On the Home
tab, for example, clicking the top half of the Paste button pastes what is on the Clipboard into
your file, but clicking the bottom half of the button opens a drop-down list with Paste options.

Keyboard Shortcuts E “ .
=

People who like to give commands by pressing keyboard shortcuts may
well ask, “Is there keyboard shortcuts in Office?” The answer is: Yes,
Ofhice has shortcuts. For example, you can press Ctrl+B to boldface text and Cerl+U tounderline
text. Office offers Alt+key shortcuts as well.

TEE'IE Chart  paste

Saving Your Files

Soon after you create a file, be sure to save it. And save your file from time to time while you work
on it as well. Until you save your work, it rests in the computer’s electronic memory (Random
Access Memory), a precarious location. If a power outage occurs, you may lose all the work you
did since the last time you saved your file. Make it a habit to save files every five Minutes or so or
when you are doing an important task. Choose the folder where you want to save a file, declare

%/ Comprehensive Computer Learning — Microsoft Office 2010



